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This presentation is for information only and does not constitute or form part of an offer, solicitation, recommendation or invitation for the sale or purchase or subscription of securities, including units in

Frasers Logistics & Commercial Trust (formerly known as Frasers Logistics & Industrial Trust) (“FLCT”, and the units in FLCT, the “Units”) or any other securities of FLCT. No part of it nor the fact of its

presentation shall form the basis of or be relied upon in connection with any investment decision, contract or commitment whatsoever. The past performance of FLCT and Frasers Logistics & Commercial

Asset Management Pte. Ltd. (formerly known as Frasers Logistics & Industrial Asset Management Pte. Ltd.), as the manager of FLCT (the “Manager”), is not necessarily indicative of the future

performance of FLCT and the Manager.

This presentation contains “forward-looking statements”, including forward–looking financial information, that involve assumptions, known and unknown risks, uncertainties and other factors which may

cause the actual results, performance, outcomes or achievements of FLCT or the Manager, or industry results, to be materially different from those expressed in such forward-looking statements and

financial information. Such forward-looking statements and financial information are based on certain assumptions and expectations of future events regarding FLCT's present and future business

strategies and the environment in which FLCT will operate. The Manager does not guarantee that these assumptions and expectations are accurate or will be realised. You are cautioned not to place

undue reliance on these forward-looking statements, which are based on the Manager’s current view of future events. The Manager does not assume any responsibility to amend, modify or revise any

forward-looking statements, on the basis of any subsequent developments, information or events, or otherwise, subject to compliance with all applicable laws and regulations and/or the rules of the

Singapore Exchange Securities Trading Limited (“SGX-ST”) and/or any other regulatory or supervisory body or agency.

The information and opinions in this presentation are subject to change without notice, its accuracy is not guaranteed and it may not contain all material information concerning FLCT. None of Frasers

Property Limited, FLCT, the Manager, Perpetual (Asia) Limited, in its capacity as trustee of FLCT, or any of their respective holding companies, subsidiaries, affiliates, associated undertakings or

controlling persons, or any of their respective directors, officers, partners, employees, agents, representatives, advisers or legal advisers makes any representation or warranty, express or implied, as to

the accuracy, completeness or correctness of the information contained in this presentation or otherwise made available or as to the reasonableness of any assumption contained herein or therein, and

any liability whatsoever (in negligence or otherwise) for any loss howsoever arising, whether directly or indirectly, from any use, reliance or distribution of this presentation or its contents or otherwise

arising in connection with this presentation is expressly disclaimed. Further, nothing in this presentation should be construed as constituting legal, business, tax or financial advice.

The value of Units and the income derived from them, if any, may fall or rise. Units are not obligations of, deposits in, or guaranteed by, the Manager or any of its affiliates. An investment in the Units is

subject to investment risks, including the possible loss of the principal amount invested. Investors should note that they have no right to request the Manager to redeem their Units while the Units are

listed. It is intended that holders of Units may only deal in their Units through trading on the SGX-ST. Listing of the Units on the SGX-ST does not guarantee a liquid market for the Units.

This advertisement has not been reviewed by the Monetary Authority of Singapore.

Nothing in this presentation constitutes or forms a part of any offer to sell or solicitation of any offer to purchase or subscribe for securities for sale in Singapore, the United States or any other jurisdiction

in which such offer, solicitation or sale would be unlawful prior to registration or qualification under the securities laws of any such jurisdiction.
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Frasers Property entities

FLCT: Frasers Logistics & Commercial Trust

FLT: Frasers Logistics & Industrial Trust

FCOT: Frasers Commercial Trust

FPL or the Sponsor: Frasers Property Limited

The Group: Frasers Property Limited, together with its subsidiaries

Financial Year

FP16: Period from 20 June 2016 to 30 September 2016

FY17: Period from 1 October 2016 to 30 September 2017

FY18: Period from 1 October 2017 to 30 September 2018

FY19: Period from 1 October 2018 to 30 September 2019

FY20: Period from 1 October 2019 to 30 September 2020

FY21: Period from 1 October 2020 to 30 September 2021

1QFY21: Period from 1 October 2020 to 31 December 2020
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Other acronyms

AEI: Asset Enhancement Initiative

CBD: Central Business District

COVID-19: Coronavirus disease 2019

EURIBOR: Euro Interbank Offered Rate

FY: Financial year

GRESB: Global Real Estate Sustainability Benchmark

GRI: Gross Rental Income

IPO: Initial Public Offering

L&I: Logistics & Industrial

NLA: Net Lettable Area

REIT: Real estate investment trust

RBA: Reserve Bank of Australia

ROFR: Right of First Refusal

SGX-ST: Singapore Exchange Securities Trading Limited

SME: Small and Medium-sized Enterprise

sq ft: Square feet

sqm: Square metres

UK: the United Kingdom

WALE: Weighted average lease expiry

WALB: Weighted average lease to break

Y-o-Y: Year-on-year

Additional notes

In the tables, the arrow direction indicates the increase (up) or decrease (down) of the absolute 

figure,  The colour indicates if the change is positive (green), negative (red) or neutral (black).
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A flagship logistics and commercial portfolio in five developed countries

97.2%

Occupancy Rate(3)

S$6.3 billion

Portfolio Value(1)(2)

97 properties

Across 5 Countries(1)

4.8 years

WALE(3)

Note: S$ values, unless otherwise stated, are based on an exchange rate of A$1.0168: S$1, €1:S$1.6220 and £1:S$1.8061 as at 31 December 2020. 

All portfolio metrics presented excludes the properties at 5 Butler Boulevard, 18-20 Butler Boulevard, and 20-22 Butler Boulevard at Adelaide Airport, South Australia which are classified as “Investment Properties Held for Sale”. 

1.As at 31 December 2020.   2. Excludes the recognition of right-of-use assets upon the adoption of FRS 116 Leases with effect from 1 October 2019.   3. Based on GRI, being the contracted rental income and estimated recoverable 

outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed leases.

Australia , 
47.0%

Germany, 
21.2% Singapore, 

20.1%

UK, 7.0%

The 
Netherlands, 

4.7%

Portfolio Value by 

Geography(1)(2)

UK 

(2 Properties)

Australia

(62 Properties)

Singapore

(2 Properties)

Germany 

(26 Properties)The Netherlands 

(5 Properties)

Industrial & Logistics (90 properties)

Commercial / Business Parks (7 properties)

Logistics & 
Industrial, 

58.7%

Office & 
Business 

Parks, 20.9%

CBD 
Commercial, 

20.4%

Portfolio Value by 

Asset Type(1)(2)
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1. Excludes three call option properties. Includes the FCOT portfolio’s book value of approximately S$2.5 billion as at 31 December 2020 and based on 100% interest in Farnborough Business Park 2. Announced on 10 December 

2020 with an expected completion in March 2021.

Over threefold net growth in portfolio size since IPO

Listed on SGX-ST 

(20 Jun 2016)  

◆ 51 Australian 

properties + three call 

options

◆ IPO price at S$0.89 

per unit

FY17

FY18

FY19

FY20
1Q

FY21

S$1.6b

AUM

◆ Proven track record in executing value-accretive acquisitions: ~S$4.5 billion(1) worth of accretive 

acquisitions to-date since IPO in June 2016

◆ Active portfolio rebalancing: ~S$460.8 million in strategic divestments all at premiums to book value

◆ Completed transformational merger with Frasers Commercial Trust in April 2020

S$1.9b

AUM

S$2.9b

AUM

S$3.5b

AUM

S$6.2b

AUM

Acquired seven new 

logistics & industrial 

(“L&I”) properties in 

Australia

Maiden acquisition of 21 

German and Dutch L&I 

properties & acquired two 

Australian L&I properties

Strengthened presence in 

Europe and Australia through 

the acquisition of 13 new L&I 

properties

Completed milestone merger 

with Frasers Commercial Trust 

introducing a new asset class and 

two new geographies

Acquired a L&I property

in Australia and a 

business park in the UK

S$6.3b

AUM

Divested two non-core 

Australian properties

FP16

Divested two non-core 

Australian properties and 50% 

interest in one Australian 

property

Divested remaining 50% interest in 

one Australian property

Divested Portfolio of 

three South Australian 

Properties(2)
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112.5
140.1

176.6

258.3

FY17 FY18 FY19 FY20

Distributable Income

S$201.1 m
▲ 48.8% 2QFY19135.1

201.1FY20

FY19

DPU

7.12 S cents
▲ 1.7%

7.00

7.12FY20

FY19

Adjusted NPI

S$258.3 m
▲ 46.2%

176.6

258.3FY20

FY19

FY2020 Results Highlight

Revenue

S$332.0 m
▲ 53.0%

217.1

332.0FY20

FY19

Adjusted Net Property Income (“NPI”)

Distributable Income

91.5 106.7
135.1

201.1

FY17 FY18 FY19 FY20

Aggregate Leverage

36.2%
S$1,811m debt headroom(1)

As at 31 December 2020

Note: FLCT has adopted S$ as its functional currency with effect from 15 April 2020, being the effective date of the merger with FCOT. Prior period results which were based in A$ were translated at the 15 April 2020 exchange rate of 

A$1: S$0.9016 used for conversion of the accounts to S$. The change in functional currency has no impact on distributable income.  1. Prior to reaching the 50.0% aggregate regulatory leverage limit.   2. Based on trailing 12 months 

borrowing cost (including FCOT from date of completion of merger). 3. As defined in the Code on Collective Investment Schemes revised by the Monetary Authority of Singapore on 16 April 2020 and clarified on 29 May 2020 and 

computed as trailing 12 months EBITDA (excluding effects of any fair value changes of derivatives and investment properties, and foreign exchange translation), over trailing 12 months borrowing costs. Borrowing costs include effects 

of FRS 116.

Cost of Borrowings

1.9%(2)

Avg. Weighted Debt Maturity

3.1 years

% of Fixed-rate Borrowings

57.4%

Interest Coverage Ratio

6.5 times(3)

(S$ million)

(S$ million)
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Well-spread Weighted Average Debt Maturity Profile of 3.1 years

Total Gross Borrowings (as at 31 December 2020): S$2,375 million

(5)

(As at 31 December 2020)

 The Manager is confident on refinancing the debt maturing in FY2021 with 

existing undrawn and new facilities

 FY2021 borrowings are expected to be partially paid down with proceeds 

from the divestment of its ownership in three leasehold industrial properties 

in South Australia(1)

155 
21 

63 

584 

67 
169 

90 

137 51 
115 

190 

81 

50 

313 

64 

3 

19 

203 

FY2021 FY2022 FY2023 FY2024 FY2025 > FY2025

DEBT MATURITY PROFILE 
(S$ MILLIONS)

£ Debt S$ Debt A$ Debt € Debt

438

698

239

133

634

233

Fixed, 
57.4%

EUR, 
23.8%

SGD, 
18.6%

AUD, 0.1%

GBP, 0.1%

Variable, 
42.6%

Interest Risk Management

(As at 31 December 2020)

1. The divestment is expected to be completed in March 2021.
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Update and commentary

 The REIT Manager is working closely with FLCT’s customers to overcome this trying period together while focusing on managing any near- to mid-term downside risk 

from the pandemic

 The COVID-19 impact on FLCT’s distributable income in 1QFY21, which includes mainly rental waiver granted and COVID-19 related provisions of approximately 

S$0.7 million, has not been material for the REIT

 The REIT Manager will continue to monitor the situation closely, support our tenants and exercise prudence 

Singapore

 Minimal impact arising from

the Re-Align Framework(1)

 Expects near- to mid-term

impact on the retail

components of the

Singapore portfolio

Europe & UK

 Limited impact on the

German and Dutch

industrial portfolio amid

ongoing lockdowns in

Europe

 Actively monitoring the

impact of the latest UK

national lockdown(2) on the

physical occupancy and

performance of the UK

properties

Australia

 Limited impact on the

industrial and commercial

properties
 Expects near- to mid-term

impact on the retail

components of the

Australian portfolio

FLCT

 No material impact to the FLCT portfolio 

to-date

 The logistics portfolio continued to operate 

during the pandemic, while the 

commercial portfolio remains largely 

stable with the retail segment representing 

a small proportion of FLCT’s overall 

income at just 2.4%(3)

 Structural changes driven by the growth 

of e-commerce activities and ‘hub-and-

spoke’ trend are expected to drive 

demand for logistics and suburban office 

spaces, respectively

FLCT’s resilient portfolio, strong balance 

sheet and financial flexibility well-

positions the REIT to face the current 

challenging global environment

1. Re-Alignment Framework, Ministry of Law.   2. Guidance, National lockdown: Stay at Home, 4 January 2021

3. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed leases. 

https://www.mlaw.gov.sg/realign/re-align-framework
mailto:https://www.gov.uk/guidance/national-lockdown-stay-at-home
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Industrial Leadership
 The industrial portfolio was named Global Sector Leader (Listed Industrial) for the third consecutive 

year in the 2020 GRESB Assessment(1)

Highest Rated 

Industrial Portfolio in 

Australia

 Highest Green Star performance-rated industrial portfolio in Australia(2)

 First to achieve 6 Star Green Star ratings for industrial facilities in each of New South Wales, Victoria 

and Queensland

Strong

Commercial 

Performance
 Top-5 in Asia Pacific Diversified – Office/Industrial

1. Refers to the 2020 Real Estate Assessments by GRESB, the global ESG benchmark for real estate. 2. Portfolio Green Star ratings as at 30 September 2020. Green Star ratings are awarded by the Green Building Council of 

Australia (GBCA) which has assessed the Australian properties against nine key performance criteria – energy, water, transport, materials, indoor environment quality management, land use and ecology, emissions and innovation.  3. 

Based on lettable area.  4. Refers to the National Australian Built Environment Rating System, Australia’s leading independent, evidence based built environment rating system.  5. Refers to the Building Research Establishment 

Environment Assessment Method, the world’s leading sustainability assessment for master planning projects, infrastructure and buildings.  6. Green Mark certification by the Building and Construction Authority, Singapore.  7. Green 

Mark re-certification for Alexandra Technopark is currently underway. Alexandra Technopark was certified Green Mark Gold prior to re-certification. 

Minimum 4.5-star 

NABERS(4) Energy 

ratings

 357 Collins Street and Caroline Chisholm Centre: minimum 5.0-star 

 Central Park: first commercial building in Australia to achieve 4.5-star NABERS Energy base building 

rating, first premium office building in Perth to attain 5.0-star NABERS Energy base building rating

BREEAM ratings(5)
 Farnborough Business Park and Maxis Business Park: ‘Excellent’/ ‘Very Good’ BREEAM ratings 

BCA Green Mark 

Gold Plus
 Cross Street Exchange: BCA Green Mark Gold Plus certification

Please visit the FLCT website for more details on its sustainability strategy and performance 

BCA rating(6)(7)



Portfolio Highlights
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Flagship portfolio of high-quality logistics and commercial 

properties in five developed countries

Stable Portfolio Performance
High occupancy rate of 97.2% with a WALE of 4.8 years

S$6.3b
Portfolio Value(2)

97
Properties(1)

As at 31 Dec 20
Logistics & 

Industrial
Commercial Total

No. of Properties 90(1) 7 97

Portfolio Value(2) S$3,693.8 m S$2,604.9 m S$6,298.7 m

Lettable Area 2,192,481 sqm 339,683 sqm 2,532,164 sqm

WALE(3) 5.5 years 4.0 years 4.8 years

WALB(3) 5.4 years 3.6 years 4.6 years

Occupancy Rate(3) 100.0% 93.6% 97.2%

Australia, 
47.0%

Germany , 
21.2%

Singapore, 
20.1%

UK, 
7.0%

The Netherlands, 
4.7%

Portfolio Value by 

Geography(2)

Logistics & 
Industrial, 

58.7%

Office & 
Business 

Parks, 20.9%

CBD 
Commercial, 

20.4%

Portfolio Value by 

Type(2)5
Countries

1. Excludes the properties at 5 Butler Boulevard, 18-20 Butler Boulevard, and 20-22 Butler Boulevard at Adelaide Airport, South Australia which are classified as “Investment Properties Held for Sale”.   2. As at 31 December 

2020 and excludes the recognition of right-of-use assets upon the adoption of FRS 116 Leases with effect from 1 October 2019.   3. Based on GRI, being the contracted rental income and estimated recoverable outgoings for 

the month of December 2020. Excludes straight lining rental adjustments and include committed leases.
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1. Excludes the properties at 5 Butler Boulevard, 18-20 Butler Boulevard, and 20-22 Butler Boulevard at Adelaide Airport, South Australia which are classified as “Investment 

Properties Held for Sale”.  

2. As at 31 December 2020 and excludes the recognition of right-of-use assets upon the adoption of FRS 116 Leases with effect from 1 October 2019.   3. Based on GRI, 

being the contracted rental income and estimated recoverable outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed 

leases.   4. 95.5% of the leases have either CPI-linked indexation or fixed escalations.   

As at 31 December 2020 Australia Europe Total

No. of Properties 59(1) 31 90

Portfolio Value(2) S$2,069.0 m S$1,624.8 m S$3,693.8 m

Lettable Area 1,311,199 sqm 881,282 sqm 2,192,481 sqm

Average Age by Value 8.4 years 8.7 years 8.4 years

WALE(3) 4.6 years 7.1 years 5.5 years

WALB(3) 4.5 years 7.0 years 5.4 years

Occupancy Rate(3) 100.0% 100.0% 100.0%

Average Annual Rental Increment 3.1% Fixed/CPI-linked(4) N.M.

Land Tenure

by Value(2)

Dutch Properties (5)

German Properties (26)

Australia

< 2 years, 
1.9%

2-5 years, 
24.0%

5-10 years, 
26.3%

>10 yrs, 
47.8%

Portfolio Age 

by Lettable 

Area

Freehold, 
65.2%

> 75 Year 
Leasehold , 

31.3%

Other 
Leasehold, 

3.5%

(12)

(16)

(1)

(3)

(30)

Germany & 

the Netherlands

Portfolio Overview – Logistics & Industrial 
Prime and modern properties in Australia, Germany and the Netherlands
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Portfolio Overview – Commercial
Quality & well-located commercial portfolio

Cross Street 

Exchange

357 Collins

Street

Central

Park

Caroline 

Chisholm 

Centre

Alexandra

Technopark

Farnborough 

Business Park

Maxis Business 

Park

As at 31 December 

2020
CBD Commercial Office and Business Parks Total

Country Singapore
Melbourne, 

Australia
Perth, Australia Canberra, Australia Singapore United Kingdom United Kingdom -

Ownership 100.0% 100.0% 50.0% 100.0% 100.0% 100.0% 100.0% -

Property Value 

(S$ m)(1)
643.3 325.2 318.7(2) 249.2 624.5 321.0 123.0 2,604.9

Lettable Area (sqm) 36,497 31,962 66,029 40,244 96,086 51,006 17,859 339,683

WALE(3) 2.7 years 2.6 years 6.2 years 4.5 years 2.8 years 5.5 years 6.2 years 4.0 years

WALB(3) 2.7 years 2.6 years 6.2 years 4.5 years 2.6 years 4.1 years 2.9 years 3.6 years

Occupancy Rate(3) 89.0% 95.5% 82.9% 100.0% 97.2% 94.0% 100.0% 93.6%

1. As at 31 December 2020 and excludes the recognition of right-of-use-assets upon the adoption o FRS116 Leases with effect from 1 October 2019. 2. Based on 50% interest in the property. 3. Based on GRI, being the 

contracted rental income and estimated recoverable outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed leases. 



15Portfolio Metrics – Leasing Activity and Reversion

1QFY21 leasing summary

1.   Calculated based on the signing gross rent (excluding any contracted fixed annual rental step-ups) of the new/renewed lease divided by the preceding terminating gross rent of each new/renewed lease (weighted by 

gross rent) of existing space.

2. Refers to reversion on leases contracted for the trailing 12-month period from 1 January 2020 to 31 December 2020.

No. of Leases Lettable Area (sqm) Average Lease Term Reversion(1)

Singapore 9 4,203 3.0 years -2.0%

Australia 1 1,330 8.0 years -29.2%

1QFY21 Reversion: -11.3%

TTM(2) Reversion: 2.0%

 Lease in Victoria, 

contracted at market 

rent, extending a prior 

lease with fixed annual 

rental increment of 

3.0% since 2011

No. of Leases Lettable Area (sqm) Average Lease Term Average Annual Increment Reversion(1)

Australia 1 14,132 1.3 years 3.0% -13.0%

Europe 4 43,881 8.5 years CPI 0.0%

1QFY21 Reversion: -3.7%

TTM(2) Reversion: -3.7%

1QFY21 Industrial Leasing Summary

1QFY21 Commercial Leasing Summary

 Lease at Central Park, 

Perth, contracted at 

market rent, replacing a 

prior lease with fixed 

annual rental increment 

of 3.75% since 2010

 Portfolio rental reversion of -6.9% for 1QFY21 (-2.1% for the 12-month period to 31 December 2020)
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2.4%

6.5% 7.1%
6.4%

5.2%

7.5%

4.7% 5.2%

1.0%

10.8%

2.8%

3.1%

5.0%

9.8%

3.7%

11.4%

1.0%

0.3%

1.8%

4.2%

Vacant Sep-21 Sep-22 Sep-23 Sep-24 Sep-25 Sep-26 Sep-27 Sep-28 Sep-29 Sep 2030
and beyond

Industrial

Commercial

11.5%

Minimal near-term lease expiries

2.8%

5.5%

16.9%

10.1%

16.6%

8.5%

5.0%

7.0%

1.1%

15.0%

1.Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed leases.

0.1%

 Well spread-out lease expiry profile with only 5.5% of GRI due for renewal in FY2021

 8 industrial and 40 commercial leases expiring in FY2021, each constituting ≤0.4% of GRI

Portfolio Lease Expiry Profile as at 31 December 2020(1)
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Top-10 Portfolio Tenants
High-quality and well-diversified tenant base 

Top-10 Portfolio Tenants(1) % of GRI WALE (Years)

Commonwealth of Australia 5.1% 4.5

Google Asia Pacific Pte Ltd 4.0% 4.0

Rio Tinto Shared Services Pty Ltd 2.5% 9.5

Commonwealth Bank of Australia 2.0% 2.0

CEVA Logistics (Australia) Pty Ltd 2.0% 4.5

BMW 1.9% 7.0

Techtronic Industries Australia Pty Limited 1.8% 2.8

Schenker Australia Pty Ltd 1.7% 3.9

Mainfreight 1.5% 5.2

Fluor Limited 1.5% 4.3

Total:

24.0%

Average:

4.3 years

1. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed leases.  

 Well-diversified tenant base with no single tenant accounting for more than 5.1% of portfolio GRI(1)

 High-quality tenant base with majority of portfolio tenants comprising Government or related entities, MNCs, conglomerates and listed 

companies

11 Gibbon Road, New South Wales, Australia
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24.0%

17.7%

6.3%
4.2%

6.9% 7.9%
5.4% 4.5%

3.3% 3.0% 2.8% 2.4% 2.4% 2.1% 1.7% 0.8%

4.6%

Well-diversified tenant base with low concentration risk

1. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed leases.   2. Excludes vacancies.  

Business Space

Logistics & Industrial 

Portfolio Tenant Sector Breakdown(1)(2)

 Stable and broad-based tenant mix with diversification across industries 

 Well-positioned to capitalise on sectoral trends with approximately one-third of the logistics and industrial portfolio(1) engaged in e-

commerce and/or e-fulfilment related activities



Market Information 

and Strategy
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$115

$94

$145

 $80

 $90

 $100

 $110

 $120

 $130

 $140

 $150

4Q16 4Q17 4Q18 4Q19 4Q20

Brisbane Melbourne Sydney

(+2.6% y-o-y)

1. Sources: Australian Bureau of Statistics and the Reserve Bank of Australia.   2. Capital Market Yields – Government Bonds – Daily (As at 4 March 2021).   3. Jones Lang LaSalle Real Estate Intelligence Service Q4 2020.

Key Economic Indicators(1) Overview of the Industrial and Commercial Market (3)

750
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1,150

1,350

1,550

1,750

1,950

2,150

4Q16 4Q17 4Q18 4Q19 4Q20

Industrial Prime Grade Net Face Rent 

(A$/sqm/yr)

10-year average

National Total Supply for Industrial 

(‘000 sqm)

Prime CBD Commercial Net Face Rent 

(A$/sqm/yr)

National Total Supply for CBD Commercial 

(‘000 sqm)

$625

$617 

 $450

 $500

 $550

 $600

 $650
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4Q16 4Q17 4Q18 4Q19 4Q20

Perth Melbourne

0

100

200

300

400

500

600

4Q16 4Q17 4Q18 4Q19 4Q20

10-year average

(+1.3% y-o-y)

(+0.0% y-o-y)

(-0.9% y-o-y)

(+0.3% y-o-y)

GDP Growth

+3.1% for the Dec 20 quarter
+3.4% for the preceding quarter

Unemployment Rate

6.4% for the month of Jan 21
Improved from 6.6% in Dec 20

Consumer Price Index

0.9% for the 12 months to Dec 20
0.7% for the 12 months to Sep 20

Cash Rate

0.1%
Unchanged since Nov 20

10-year bond yield

1.73%
As at 4 Mar 21(2)

Key economic indicators and market overview 

https://www.quandl.com/data/RBA/F02-Capital-Market-Yields-Government-Bonds-Daily
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Key economic indicators and market overview 

Unemployment Rate

4.4% for the month of Dec 20

From 4.5% in Nov 20

Consumer Price Index 

1.0% for the 12 months to Jan 21

From -0.3% in Dec 20

• Take-up in Germany remained reasonably high in 2020, dipping only 0.9% year-on-year despite 

the COVID-19 pandemic throughout the year. Demand is largely driven by the e-commerce 

market which saw several large transactions transacted. 

• Prime rents increased slightly in major logistics hubs as a result of limited supply and 

transactions signed for speculative developments of logistics parks.

• Investment volumes recorded close to €8 billion in 2020 across the major logistics hubs, an 

increase of 5.5% year-on-year. 

• Prime yields decreased to a historic 3.35% in the fourth quarter, compared to 3.50% in the 

preceding quarter and 3.70% in 2019. This is the lowest yield recorded in Europe.

Overview of the German Industrial Market(3)

EURIBOR

-0.541% 3-month EURIBOR

Remained in the negative range(2)

Take-up and Prime Rents in Germany (for warehouses >5,000 sqm)

Key Economic Indicators in Germany(1)

GDP 

+0.3% for the Dec 20 quarter

+8.5% for the preceding quarter

Key Economic Indicators in the Netherlands(4)

Overview of the Dutch Industrial Market(3)

• Take-up levels broke new records in 2020, just below the 3 million sqm threshold. Activity was

boosted by demand from retail and distribution sectors, which accounted for nearly half of

total take-up.

• Prime rents have remained largely stable. However, as demand increased significantly over

the past three years, supply has dried up especially for good quality warehouses. This may put

more pressure on market rents.

• Investment volumes achieved in 2020 was just above the 5-year average.

• Prime yields have dropped to a historic 3.8% in the Netherlands in the fourth quarter, as

compared to 3.9% in the preceding quarter. There are no existing signs of decompression.

Take-up and Prime Rents in the Netherlands (for warehouses >5,000 sqm)
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1. Source: Destatisches Bundesamt (Federal Statistics Office of Germany). 2. Source: https://www.euribor-rates.eu/en/current-euribor-rates/ (As at 4 March 2021). Applicable for both Germany and the Netherlands. 3. Source: BNP 

Paribas Real Estate Q4 2020.   4. Source: CBS (Statistics Netherlands).  
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Unemployment Rate

3.6% for the month of Jan 21

From 3.9% in Dec 20

Consumer Price Index 

1.6% for the 12 months to Jan 21

From 1.0% for the 12 months to Dec 20

GDP 

-0.1% for the Dec 20 quarter

From +7.8% in the preceding quarter

https://www.euribor-rates.eu/en/current-euribor-rates/
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1. Sources: Singstat, Ministry of Trade and Industry Singapore, Ministry of Manpower Singapore.   2.Source: MAS SGS.   3. Source: CBRE, Singapore Market View, Q4 2020.   4. Alexandra Technopark is a high-specification B1 

industrial development located at the city-fringe, with certain physical attributes similar to business parks. Due to limited availability of market research information directly relating to the asset class of Alexandra Technopark, market 

research information for business parks is provided for indicative reference.

Overview of the Singapore Office and Business Park Markets(3)

Office Supply-Demand Dynamics

Net supply Net absorption Vacancy rate (RHA)
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Business Park Supply-Demand Dynamics

Grade A and Grade B Office Rents 

(S$ psf per month)
Business Park Rents(4)

(S$ psf per month) 

Net supply Net absorption Vacancy rate (RHA)
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Key Economic Indicators(1)

GDP Growth

+2.1% for the Dec 20 quarter
+9.5% in the preceding quarter

Unemployment Rate

3.2% for the Dec 20 quarter
3.6% for the Sep 20 quarter

Consumer Price Index 

0.2% for the 12 months to Jan 21
0.0% for the 12 months to Dec 20

Singapore Overnight Rate(2)

0.2477%
As at 26 Feb 21

10-year bond yield

1.54%
As at 5 Mar 21(2)

Key economic indicators and market overview 



231. Source: Office for National Statistics.   2. Source: Bank of England, published December 2020.  3. Source: CBRE Research South East Q4 2020.

South East Office Trends and Outlook(3)

• Take-up levels totaled close to 2 billion sq ft in 2020, which is a 24% decline year-on-year as

compared to 2019. The development pipeline remains severely constrained with just 1.2 million sq

ft under construction across 16 schemes in the South East.

• Prime rents have remained largely stable across the South East office market.

• Investment volumes were recorded at £2.6 billion in 2020, showing only a dip of 11% year-on-year

despite the COVID-19 pandemic situation that existed throughout the year. Investment volumes are

expected to pick up in the first quarter of 2021.

4,443

3,231

4,280

3,032 2,900 2,590

0

1,500

3,000

4,500

6,000

2015 2016 2017 2018 2019 2020

(£ mil) South East Office Investment Volumes

Full Year 5-Year Average (2016-20)

Key Economic Indicators(1)

South East Office Headline Rents
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Bracknell Farnborough

GDP Growth

+1.0% for the Dec 20 quarter
+16.1% in the preceding quarter

Unemployment Rate

5.0% for the three months to Nov 20
4.9% for the three months to Oct 20

Consumer Price Index 

0.9% for the 12 months to Jan 21
0.8% for the 12 months to Dec 20

Bank Rate

0.1%
Unchanged since March 20

Key economic indicators and market overview 



Harnessing FLCT’s competitive advantages to create long-term value and sustainable 

returns

◆ Our Objectives:

Deliver stable and regular distributions to unitholders

Achieve sustainable long-term growth in DPU 
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FLCT objectives and strategies

Active Asset

Management

 Proactive leasing to maintain 

high occupancy rate, long 

WALE and a diversified tenant 

base

 Assess and undertake AEIs(1)

to unlock further value

Selective

Development

 Development of properties 

complementary to the existing 

portfolio

 Re-development of existing 

assets and by leveraging the 

Sponsor’s development 

pipeline

Acquisition

Growth

 Pursue strategic acquisition 

opportunities of quality 

properties

– Sponsor’s ROFR, with a value 

in excess of S$5 billion 

– Third party acquisitions

Capital & Risk 

Management

 Optimise capital mix and 

prudent capital management

1. Development activities can be up to 10% of the current AUM as per MAS guidelines. FLCT may exceed the regulatory limit of not more than 10% of the company’s deposited property (subject to maximum of 25%) only 

if additional allowance of up to 15% of the deposited property is utilised solely for redevelopment of an existing property that has been held for 3 years and continues to be held for 3 years after completion and specific 

approval of unitholders for redevelopment is obtained. 



Appendix: 

Additional Financial & Portfolio Information 

Section Divider To add a background, press Insert > Pictures > Picture from File > Send to back

Caroline Chisholm Centre, Canberra, Australia
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Breakdown by asset type

1.Based on GRI and includes committed leases.  

Logistics & Industrial As at 31 Dec 20 As at 30 Sep 20 Change

Australia 100.0% 100.0% -

Europe 100.0% 100.0% -

Logistics & Industrial Portfolio: 100.0% 100.0% -

Appendix: Occupancy Rate

Commercial Country As at 31 Dec 20 As at 30 Sep 20 Change

Cross Street Exchange Singapore 89.0% 89.5% ▼ 0.5%

Alexandra Technopark Singapore 97.2% 97.9% ▼ 0.7%

Central Park Australia 82.9% 80.8% ▲ 2.1%

Caroline Chisholm Centre Australia 100.0% 100.0% -

357 Collins Street Australia 95.5% 95.9% ▼ 0.4%

Farnborough Business Park United Kingdom 94.0% 99.3% ▼ 5.3%

Maxis Business Park United Kingdom 100.0% 100.0% -

Commercial Portfolio: 93.6% 94.3%
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Top-10 Logistics & Industrial Tenants(1)

% of FLCT 

Portfolio GRI WALE (Years)

Ceva Logistics, Australia 2.0% 4.5

BMW, Germany 1.9% 4.7

Techtronics Industries, Australia 1.8% 2.8

Schenker, Australia 1.7% 3.9

Mainfreight, the Netherlands 1.5% 5.2

Hermes, Germany 1.4% 12.0

Constellium, Germany 1.3% 6.4

Bakker Logistics, the Netherlands 1.3% 9.9

Bosch, Germany 1.2% 7.6

Martin Brower Australia Pty Ltd 1.2% 15.7

Total:

15.3%

Average:

7.0 years

1. Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed leases.   

Top-10 Commercial Tenants(1)

% of FLCT 

Portfolio GRI

WALE 

(Years)

Commonwealth of Australia 5.1% 4.5

Google Asia Pacific, Singapore 4.0% 4.0

Rio Tinto, Australia 2.5% 9.5

Commonwealth Bank of Australia 2.0% 2.0

Fluor Limited, United Kingdom 1.5% 4.3

WeWork, Australia and Singapore 1.2% 9.4

GroupM Singapore Pte Ltd, Singapore 1.0% 2.6

Service Stream, Australia 1.0% 3.9

Syneos Health UK Ltd, UK 0.9% 7.1

Suntory Beverage & Food Asia Pte Ltd, 

Singapore
0.7% 2.4

Total:

19.9%

Average:

5.0 years

Appendix: Top-10 Tenants
Breakdown by asset type
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0.0%

2.0%

5.7% 5.7% 5.3%

3.5%

4.6%

2.9%
2.4%

0.0%

4.1%0.3%

0.8%
1.4%

1.0%

1.7%

3.0%

1.8% 2.8%

1.0%

6.7%

Vacant Sep-21 Sep-22 Sep-23 Sep-24 Sep-25 Sep-26 Sep-27 Sep-28 Sep-29 Sep 2030
and beyond

Australia

Germany and the Netherlands

6.5%

7.6%

1.0%

7.1%

6.3%

5.2%

4.7%

5.2%

10.8%

1.Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed leases.

2.3%

Appendix: Lease Expiry Profile

Industrial Portfolio Lease Expiry Profile as at 31 December 2020(1)

(% of total FLCT Portfolio GRI)

Logistics & Industrial        
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1.3%
0.6% 0.4%

3.0%

0.6%

6.4%

0.0% 0.3%
0.2%

0.1%

3.2%
1.1% 2.4%

3.1%

4.0%

2.8%

3.9%

0.1%

0.5%

0.7%

0.4%
0.2%

1.4%

2.7%

0.4%

1.2%

0.8%

0.0% 1.2%

0.0%

0.3%

Vacant Sep-21 Sep-22 Sep-23 Sep-24 Sep-25 Sep-26 Sep-27 Sep-28 Sep-29 Sep 2030
and beyond

Australia Singapore UK

2.8%

4.9%

9.7%

3.8%

0.9%

11.5%

0.3%

1.9%

4.2%3.2%

1.Based on GRI, being the contracted rental income and estimated recoverable outgoings for the month of December 2020. Excludes straight lining rental adjustments and include committed leases.

Commercial Portfolio Lease Expiry Profile as at 31 December 2020(1)

(% of total FLCT Portfolio GRI)

Appendix: Lease Expiry Profile
Commercial 
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6,327

2,988

1,625
1,269

445

2,375

393

1,059
698

225

Total Portfolio Australian Portfolio European Portfolio Singapore Portfolio UK Portfolio

Investment Properties
Total: S$6,327 million

Debt
Total: S$2,375 million

1. Includes Investment Properties Held for Sale and excludes recognition of right-of-use assets upon the adoption of FRS 116 Leases with effect from 1 October 2019. 2. Refers to debt in the currency or hedged 

currency of the country of the investment properties.

Investment Properties(1) and Debt(2) as at 31 December 2020

Adopting a natural hedge while taking into consideration cost of borrowings



Appendix: 

Additional Market Information

Section Divider To add a background, press Insert > Pictures > Picture from File > Send to back

Alexandra Technopark, Singapore
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Sydney Industrial Final Data 4Q20; Jones Lang LaSalle Real Estate Intelligence Service – Sydney Industrial Snapshot 4Q20; Jones Lang LaSalle Real Estate Data 

Solution – Sydney Construction Projects from Q1 2011 to 4Q 2020; Knight Frank Research – Sydney Industrial Market Report August 2020. 

Sydney Industrial Total Supply Sydney Industrial Prime Grade Net Face Rents 

◆ Supply: Over the last 12 months, development activity in Sydney continued to outperform the 10-year average, with 549,828 sqm of new stock being completed. New construction continues

to be concentrated in the Outer South Western, Outer North West and Inner West precincts. The largest completion during the quarter was a 36,287 sqm cold storage facility at Lot 124

Hollinsworth Road, Marsden Park.

◆ Demand: Industrial take-up levels remain above the 10-year average despite the continued negative economic uncertainly caused by the COVID-19 pandemic. During the quarter Sydney recorded

218,612 sqm of gross take-up. The quarter was dominated by Transport, Postal & Warehousing, Manufacturing and Retail Trade users. The largest transaction of the quarter was the 54,952 sqm

lease to Linfox at 40-88 Forrester Road, St Marys.

◆ Rents: The continued low vacancy rates and a shortage of developable land has translated to an average y-o-y rental growth of approximately 2.6% across all industrial precincts. The Outer

Central West continues to be the strongest performing precincts with net face rents growing by 4.4% to A$128/sqm. Prime industrial incentives have increased slightly although they remain relatively

low compared to other markets with average prime incentives in the Outer Central West currently sitting at 16%.

◆ Vacancy: As at July 2020, Industrial vacancies in Sydney remain near historic 5-year lows with approximately 541,025 sqm of available space. Sydney industrial vacancy are expected to

increase over the next 12 months as new speculative stock is completed.
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Melbourne Industrial Final Data 4Q20; Jones Lang LaSalle Real Estate Intelligence Service – Melbourne Industrial Snapshot 4Q20; Jones Lang LaSalle Real 

Estate Data Solution – Melbourne Construction Projects from Q1 2011 to 4Q 2020; Knight Frank Research – Melbourne Industrial Market Report August 2020. 

Melbourne  Industrial Total Supply Melbourne Industrial Prime Grade Net Face Rents 

◆ Supply: A total of eight projects with a total of 236,538 sqm reached practical completion in Melbourne over the fourth quarter of 2020 (“4Q20”). While this is 22% below 3Q 2020 total, it is more than

double the 10-year quarterly average of 112,650 sqm. In 4Q 2020, the bulk of new industrial supply were concentrated in the Western Precinct (49%) and Northern Precinct (38%), reflective of their

less restrictive land supply environments.

◆ Demand: With lockdown restrictions easing in Victoria, occupier movement has certainly accelerated. Gross take-up for 4Q 2020 totalled 470,230 sqm, the highest total recorded for the

Melbourne market, exceeding the 10-year quarterly average of 182,650 sqm. The largest transaction of the quarter was a 118,000 sqm leased to Basic Chemical & Chemical Product

Manufacturing at Melbourne Airport Business Park, Airport Drive.

◆ Rents: High levels of development activity and the addition of new supply has softened the average y-o-y rental growth in Melbourne. Industrial face rents in Melbourne have generally remained flat

across all precincts except for the South East. The South East continues to be the strongest performing precinct with face rents maintained at A$93/sqm net over the previous 12 months.

Incentives in South East have also remained stable at around 23%.

◆ Vacancy: Melbourne vacancies have increased 19% over the previous financial year. As at July 2020, there was approximately 834,023 sqm of available industrial space in the Melbourne market.

However, vacancy rates in Melbourne are expected to increase over the next 12 months as new speculative stock is completed.
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Brisbane Industrial Final Data 4Q20; Jones Lang LaSalle Real Estate Intelligence Service – Brisbane Industrial Snapshot 4Q20; Jones Lang LaSalle Real Estate Data 

Solution – Brisbane Construction Projects from Q1 2011 to 4Q20; Knight Frank Research – Brisbane Industrial Market October 2020.

Brisbane Industrial Total Supply Brisbane Industrial Prime Grade Net Face Rents 

◆ Supply: Over the last 12 months, development activity in Brisbane has exceeded the 10-year average, with 416,588 sqm of new stock being added to the market, marking the strongest annual

completion since 2014. New construction continues to be concentrated in the Southern precinct. The largest completion during the quarter was the 25,400 sqm Willawong Distribution Centre Stage 2

at Willawong. The supply pipeline remains relatively strong with 8 projects under construction, totalling 166,500 sqm which are expected to complete in 2021.

◆ Demand: Tenant demand for industrial space has also remain subdued with Brisbane recording take-up of 84,068 sqm in 4Q 2020. The largest transaction of the quarter was a 12,000 sqm pre-lease

to Impact Fertilisers at Radio Street Warehouse and Office, 38 Radio Street, which is slated for completion in 4Q 2021. Occupier demand remained below the 5-year quarterly average of 119,122

sqm.

◆ Rents: Rental rates remained stable for the fourth consecutive quarter across Brisbane over 4Q 2020, with recent deals maintaining at pre-COVID rates. The Southern industrial precinct has

experienced stable rental growth with average rent remaining stable at A$110/sqm net. The average incentive did however increase across the market, rising from 17% to 18%. Incentives in Brisbane

South have remained stable at 20% for prime industrial assets, incentives are higher compared to Brisbane’s Northern and Trade Coast industrial markets.

◆ Vacancy: Vacancy levels in Brisbane have increased 3.4% in Q3 2020 as a result of speculative developments reaching completion and tenants relocating to purpose-built facilities. As at October

2020, the level of available industrial space is approximately 596,173 sqm. However, vacancy rates in Brisbane are expected to increase over the next 12 months as new speculative stock is

completed.
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Melbourne CBD Office Final Data 4Q20; Jones Lang LaSalle Real Estate Intelligence Service – Melbourne  CBD Office Snapshot 4Q20; Jones Lang LaSalle Real 

Estate Data Solution – Melbourne CBD Office  Construction Projects from 1Q 2011 to 4Q 2020.

Melbourne Commercial Total Supply Melbourne Prime Grade Net Face Rent

◆ Supply: There were no new major commercial developments completed in the Melbourne CBD in Q4 2020. During 2020, a total of seven new projects were completed in the Melbourne CBD 

contributing approximate 329,000 sqm of net lettable area (“NLA”) making 2020 the highest year for completions since 1991. Approximately 95% of the new completions in 2020 were pre-committed and 

have not significantly contributed to vacancy rates in the Melbourne CBD. 

◆ Demand: As a result of the economic uncertainly regarding the COVID-19 pandemic, tenant demand in Melbourne CBD has continued to decline. In 4Q 2020, Melbourne recorded a gross take-up of 

14,265 sqm. During Q4 2020, Melbourne CBD experienced negative net absorption of 68,152 sqm as tenants continue to offer sublease space to the market. During the calendar year 2020 Melbourne 

recorded a negative net absorption of 188,775 sqm .

◆ Rents: Tenant demand in the Melbourne CBD has remained subdued over 2020 and has resulted in a sharp increase in vacancies and incentives. Over  the last 12 months average net prime rents in 

Melbourne CBD have declined by 0.9% to A$617/sqm. Prime incentives in the Melbourne CBD have also increased slightly over the quarter and are currently at 33%. The decline in face rents and the 

increase of incentives has resulted in negative effective rental growth over the quarter. 

◆ Vacancy: As at 4Q 2020, the vacancy rate in Melbourne’s CBD rose from 11.34% in the preceding quarter to 13.17% the highest levels since 1999. This increase is due to weak tenant demand as well 

as an increase in sublease space as well as several large tenant contractions. As at 31 December 2020, there is approximately 672,441 sqm of vacant commercial space in the Melbourne CBD market.  

According to JLL vacancies are expected to peak in 2021 as new supply reaches completion and the COVID-19 pandemic continues to negatively affect business confidence and tenant demand. 
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Sources: Jones Lang LaSalle Real Estate Intelligence Service – Perth CBD Office Final Data 4Q20; Jones Lang LaSalle Real Estate Intelligence Service – Perth CBD Office Snapshot 4Q20; 

Jones Lang LaSalle Real Estate Data Solution – Perth CBD Office Construction Projects from Q1 2011 to 4Q20. 

Perth CBD Office Total Supply Perth CBD Office Prime Grade Net Face Rent

◆ Supply: Development activity in the Perth CBD has been subdued with no new space completed in the last 12 months. There are currently two major new developments under construction in the

Perth CBD - Chevron HQ and Capital Square Tower 2. The two developments are expected to be completed in 4Q 2023 and 4Q 2021 respectively and will provide approximately 79,200 sqm of

commercial space to the Perth Market.

◆ Demand: During 4Q 2020, demand for commercial space in the Perth CBD was subdued with four leases over 1,000 sqm signed during the quarter totalling 9,114 sqm. The largest lease transaction

of the quarter was a 3,600 sqm lease to Gold Fields at 235-239 St Georges Terrace, Perth. Despite the ongoing COVID-19 pandemic, the Perth CBD market recorded a positive gross take up of

6,848 sqm during 4Q 2020.

◆ Rents: Despite softening demand, prime rents in the Perth CBD remained stable over the previous 12 months. The average net prime rents in the Perth CBD are currently A$625/sqm. Over the

previous 12 months, incentives for prime office space have increased slightly and are currently at 49%. The high-level of incentives is due to continued high vacancy rates and modest tenant demand

in the Perth CBD office market.

◆ Vacancy: As at 4Q 2020, the vacancy rate in Perth CBD decreased slightly to 20.0%. Currently, there is approximately 361,779 sqm of vacant commercial space in the Perth CBD market.

Vacancy rates are expected to increase in the short-term as the economic impacts of the COVID-19 pandemic continue to negatively affect business confidence and tenant demand.
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37Source: CBRE, Singapore Market View, Q4 2020.

Singapore Grade A and Grade B office rents

◆ Supply: There has been no new office completions in Q4 20, bringing total new completions in the 12-month period to 31 December at 1.2 mil sq ft. The bulk of the office supply 

will be injected into the market from 2021 to 2023, with bigger projects that include Capitaspring, Guoco Midtown and Central Boulevard Towers slated for completion by 2023. 

◆ Demand: Total net absorption in 4Q20 was negative at 14,819 sq ft, the third consecutive quarter of negative net absorption mainly due to the lacklustre demand as a result of 

the COVID-19 pandemic and a weaker economic outlook. In 4Q20, corporates in the banking and insurance sectors started the trend of consolidating and paring down their real 

estate footprint as flexible work arrangements become more widely adopted. Encouragingly, demand from the information and technology communications (ICT) firms continue to 

be active in the office market.

◆ Rents: Generally, rents in 4Q20 have declined quarter-on-quarter due to weaker business sentiment and subdued underlying new demand. With vacancy rates expected to rise, 

landlords are realigning rental expectations, thus narrowing the rental expectation gap between tenants and landlords 

◆ Vacancy: Coupled with lower occupancy of the new-builds upon completion, as well as the impact of slower demand with firms re-evaluating their real estate footprint and 

downsizing, vacancy rose from 4.5% in 4Q19 to 6.0% in 4Q20.
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Source: CBRE, Singapore Market View, Q4 2020.

1. Alexandra Technopark is a high-specification B1 industrial development located at the city-fringe, with certain physical attributes similar to business parks. Due to limited availability of market research information directly relating 

to the asset class of Alexandra Technopark, market research information for business parks is provided for indicative reference.

Singapore Business Park rents

◆ Supply: The completion of on-going projects are expected to be delayed by at least three months due to disruptions in the construction industry. From 2021 to 2023, an 

estimated 4.15 million sq ft of new supply will come on stream.

◆ Demand: For 2020, the technology sector continued to be a demand driver for the business park market, especially in the City Fringe submarket. Total island wide net 

absorption was 50,488 sq ft in Q4 2020. Given tight vacancy in the City Fringe submarket, space within the Rest of Island submarket has been receiving keen interest from more 

cost-conscious occupiers seeking space. Demand for business parks is expected to remain steady with the strong emphasis on high-tech industries.

◆ Rents: With the performance of the business park market displaying some resilience in this quarter, rents in City Fringe Business Parks and Rest of Island submarkets kept 

stead at S$5.80 psf/month and S$3.70 psf/month, unchanged since last quarter

◆ Vacancy: Island wide vacancy rate eased slightly from 13.0% in 3Q20 to 12.8% in 4Q20 with no new supply over the past three months. Occupancy rate is unlikely to dip 

significantly as there is limited large contiguous space in city fringe business parks 

Singapore business park 

rents

4Q20

(psf/ month)

Q-o-q

(%)

City fringe S$5.80 unchanged

Rest of Island S$3.70 unchanged




